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I. Système optique 
 

1. Matériel 

 

Pour notre montage, nous nous sommes grandement inspirés du modèle proposé par 

OpenSPIM, plateforme en libre accès qui propose un guide très complet pour les 

membres de la communauté scientifique désireux de monter leur propre système de 

microscopie à nappe de lumière. La liste du matériel conseillé par OpenSPIM est 

disponible sur cette page : https://openspim.org/Table_of_parts. 

 

Voici les principaux éléments que nous avons utilisé : 

 

- 1/2" (Ø12.7 mm) SM05-Mounted Frosted Glass Alignment Disk w/Ø1 mm Hole, 

Thorlabs, 29,52€ 

- Metric optical breadboard 

(https://www.thorlabs.de/newgrouppage9.cfm?objectgroup_id=159&pn=MB3045/

M#1996) 

-  2x f=60 mm, Ø1" Achromatic Doublet, SM1-Threaded Mount, ARC: 400-700 nm 

(Thorlabs, 2x 96,40€) 

- 1x f=30 mm, Ø1" Achromatic Doublet, SM1-Threaded Mount, ARC: 400-700 nm 

(Thorlabs, 2x 103,28€) 

- Ø1" (Ø25.4 mm) Cylindrical Achromat, f = 50 mm, ARC: 350 - 700 nm (Thorlabs, 

369,85 €) 

- Water dipping objective lens (10x/NA=0.3) (Olympus, UMPLFLN 10xW, 1 105 €) 

- Water dipping objective lens (20x/NA=0.5) (Olympus, UMPLFLN 20xW, 1 996 €) 

- Hamamatsu ORCA-Flash4.0 LT Digital Camera 

- Laser Oxxius LBX-488 (wavelength 488 nm, 100 mW : 

https://www.oxxius.com/products/low-noise-lasers/) 

- 2 single-band bandpass filters, around 488 nm and 520 nm (Semrock, 2x 345 €, 

https://www.semrock.com/FilterDetails.aspx?id=FF02-472/30-25, 

https://www.semrock.com/FilterDetails.aspx?id=FF01-520/35-25) 

 

En plus de ces éléments principaux, nous avons également utilisé de nombreux éléments 

Thorlabs de base (vis, pieds, etc). Le matériel nécessaire pour monter les échantillons 

biologiques et les translater est détaillé dans la partie sur le montage des pupes. 

 

2. Mise en place du système optique 

 

Le schéma optique du montage est présenté en figure 1 : 

 

https://openspim.org/Table_of_parts
https://www.thorlabs.de/newgrouppage9.cfm?objectgroup_id=159&pn=MB3045/M#1996
https://www.thorlabs.de/newgrouppage9.cfm?objectgroup_id=159&pn=MB3045/M#1996
https://www.oxxius.com/products/low-noise-lasers/
https://www.semrock.com/FilterDetails.aspx?id=FF02-472/30-25
https://www.semrock.com/FilterDetails.aspx?id=FF01-520/35-25
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Figure 1 - Schéma optique du montage 

 

 
Figure 2 - Photo du montage vu du dessus 

 

Pour distinguer le signal fluorescent du bruit lumineux ambiant, il est important d’isoler 

tout le système optique. Pour cela, nous avons entouré notre système d’un cadre de carton 

noir, et nous avons également recouvert la cage qui entoure le chemin optique de carton 

noir. 
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II. Alignement du laser 
 

Tous les éléments du système optique sont alignés à l’aide d’une cage constituée de tiges 

métalliques (https://www.thorlabs.com/newgrouppage9.cfm?objectgroup_id=4124). Il 

faut ensuite que le faisceau laser soit bien aligné avec cette cage : le moindre petit 

décalage par rapport au centre des lentilles peut dévier le faisceau, et cette déviation se 

fera d’autant plus ressentir à grande distance, et nous avons besoin que tout le faisceau 

rentre bien au centre de la lentille cylindrique et de l’objectif pour former une belle nappe 

laser avec un maximum de signal. 

 

Le matériel nécessaire à l’alignement du laser est le suivant : 

- deux miroirs à inclinaison réglable (Thorlabs) 

- une cible d’alignement 

(https://www.thorlabs.com/newgrouppage9.cfm?objectgroup_id=7296, Cage 

Alignment Plates, ces cibles peuvent être posées sur la cage métallique) 

 

Placer la cible vers la fin du montage optique. Déplacer le faisceau à l’aide des miroirs 

pour atteindre le centre de la cible : un miroir sert à se déplacer verticalement, et l’autre 

horizontalement. Toujours utiliser le même miroir pour le déplacement vertical, de même 

pour le déplacement horizontal. Ramener la cible au début du montage, et aligner le 

faisceau au centre. Remettre la cible en fin de montage, régler, et continuer à aligner le 

laser en alternant début et fin de montage jusqu’à ce qu’un réglage au début du montage 

ne fasse plus bouger le faisceau en dehors du centre de la cible en fin de montage. Le 

faisceau laser est alors correctement aligné. 

 

III. Culture de drosophiles 
 

1. Choix des lignées 

 

Pour obtenir un maximum de signal, nous nous sommes tournés vers des lignées de 

drosophiles exprimant la GFP de manière ubiquitaire, c’est-à-dire couplée à des protéines 

exprimées dans de nombreuses cellules et en grande quantité, indépendamment du stade 

de développement, comme les protéines d’adhérence, la tubuline, la myosine ou encore 

l’actine. 

 

La base de données couramment utilisée est FlyBase : http://flybase.org/ 

 

Nos lignées nous ont été fournies par un laboratoire de l’Institut Pasteur, que nous 

remercions pour leur aide : https://research.pasteur.fr/fr/team/cell-death-and-epithelial-

homeostasis/ (contact : Léo Valon). 

 

Les lignées utilisées pour mettre en application notre montage sont les suivantes : 

 

● sqh-utABD::GFP/Cyo ; sqh-MoesABD::mCherry/TM6b 

(sqh → regulatory light chain of the nonmuscle type 2 myosin) 

https://www.thorlabs.com/newgrouppage9.cfm?objectgroup_id=4124
https://www.thorlabs.com/newgrouppage9.cfm?objectgroup_id=4124
https://www.thorlabs.com/newgrouppage9.cfm?objectgroup_id=7296
https://www.thorlabs.com/newgrouppage9.cfm?objectgroup_id=7296
http://flybase.org/
https://research.pasteur.fr/fr/team/cell-death-and-epithelial-homeostasis/
https://research.pasteur.fr/fr/team/cell-death-and-epithelial-homeostasis/
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● endo-Ecad::GFP (KI) , ubi-H2A::mRFP /Cyo 

(GFP sur la cadhérine E) 

 

 

2. Cycle de vie de la drosophile 

 

La durée de vie et le cycle de reproduction de la mouche du vinaigre (Drosophila 

melanogaster) dépend de la température. La figure ci-dessous présente le cycle de 

reproduction de la drosophile à 25°C. 

 

 

Figure 3 - Cycle de reproduction de D. melanogaster à 25°C [1] 

 

Pour mettre en application notre montage, nous avons choisi le stade pupal, qui présente 

l’avantage d’être immobile, facilement prélevable dans le tube de culture (voir protocole) 

et facilement manipulable. 

 

3. Matériel 

 

Le matériel pour la culture des drosophiles nous a été fourni par le Laboratoire de 

Plasticité du Cerveau (ESPCI, contact : Alice Pavlowsky) : 

- tubes de culture en verre, avec bouchons en mousse 

- milieu de culture 

 

Nos cultures ont été réalisées à température ambiante, mais pour plus de contrôle sur le 

temps du cycle de reproduction, on peut placer les tubes dans un incubateur (18 à 25-

30°C selon la durée des cycles souhaitée). 
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Protocole pour la préparation du milieu de culture : 

 

Matériel nécessaire (pour 30 L de milieu) : 

- 500 mL d’éthanol technique (absolu, 99,99°) 

- 100 g de 4-hydroxybenzoate de méthyle (antifongique) 

- 30 L d’eau 

- 2 kg de farine de maïs (Limagrain Céréales Ingrédients, westhove maize H1) 

- 1,8 kg de levure de bière Springaline BA10/0 BioSpringer 

- 260 g d’agar-agar en poudre (VWR, référence : 20768.361) 

 

Instructions : 

- Dissoudre l’antifongique dans l’éthanol dans un grand bécher. 

- Mettre 30 L d’eau chaude dans une marmite. Laisser chauffer sans agitation jusqu’à 

80°C. 

- Sous agitation vigoureuse et en maintenant une température élevée, mélanger 

dans l’ordre dans la marmite : la farine de maïs, la levure de bière, et enfin l’agar-

agar. Couvrir et maintenir l’agitation pendant 5 minutes. 

- Ajouter lentement le mélange éthanol-antifongique. 

- Couvrir et agiter pendant 25 minutes, toujours à température élevée. 

- Répartir dans les tubes, sur une hauteur de 2,5 à 3 cm. 

 

4. Protocole pour la culture 

 

Introduire des drosophiles dans un tube contenant du milieu de culture au fond. Quelques 

jours après, les drosophiles auront pondu dans le milieu. Les drosophiles consomment 

peu à peu le milieu : pour entretenir la culture, il faut procéder au repiquage (à faire tous 

les 2 à 5 jours selon la température). Le protocole pour repiquer la culture est le suivant : 

 

1. Préparer le tube à repiquer et un nouveau tube contenant du milieu. 

2. Tapoter le tube contenant les drosophiles sur la table pour faire tomber les 

mouches au fond. 

3. Ouvrir le tube et transférer rapidement les drosophiles dans le tube neuf 

(superposer les deux tubes et tapoter pour faire tomber les drosophiles dans le 

nouveau tube). 

4. Refermer les deux tubes. 

5. Bien noter la date de repiquage sur le nouveau tube, ainsi que la référence de la 

lignée de drosophiles. 

 

Dans le premier tube, des larves vont se développer dans le milieu, monter sur les parois 

et passer au stade pupal, pour enfin donner des adultes. Lorsque les tubes deviennent 

anciens, il ne reste plus beaucoup de milieu : ces tubes sont alors jetés (si ce sont des 

tubes en verre, ils peuvent être récupérés après passage à l’autoclave, dans ce cas il faut 

bien penser à retirer les étiquettes en papier). 
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Figure 4 - Tubes de culture avec des pupes accrochées sur les parois 

 

Nous remercions le LPC pour l’aide apportée dans ce projet, pour le prêt du matériel et la 

mise à disposition d’espace dans leur laboratoire pour nos manipulations. 

 

IV. Montage des pupes de drosophiles dans le système optique 
 

1. Méthode choisie 

 

Nous avons choisi d’utiliser des objectifs à immersion dans l’eau, et de suspendre les 

pupes à imager dans un gel d’agarose, lui-même immergé dans l’eau. A l’aide d’une 

seringue, on fait pendre un petit cylindre d’agarose contenant la pupe, et ce cylindre est 

immergé dans l’eau. 

 

La seringue est reliée à trois platines de translations, permettant de se déplacer selon les 3 

axes x, y, z. Les platines pour les axes x et y sont contrôlées manuellement, mais la platine 

de translation selon z (pour obtenir des plans à différentes profondeur de l’échantillon) est 

une platine piézo-électrique qui se contrôle plus finement grâce à un contrôleur 

électronique, et qui peut également être contrôlée depuis un ordinateur. Dans notre 

méthode, c’est bien l’échantillon qui se déplace, et non les objectifs. 

 

 
Figure 5 - Système de montage des échantillons. Les objectifs à immersion sont insérés 

dans une cuve remplie d’eau. La platine de translation visible ici est la platine PD1/M 

contrôlable finement par ordinateur. 
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2. Matériel 

 

La chambre d’immersion de l’échantillon est une pièce que nous avons imprimé en 3D, en 

utilisant le fichier 3D proposé sur OpenSPIM. Le polymère que nous avons utilisé est 

l’acide polylactique. Ce  polymère pose quelques problèmes d’étanchéité. Il est possible 

d’imperméabiliser la surface en la lissant à l’aide d’acétone. Le reste du matériel nécessaire 

au montage d’échantillons est le suivant : 

 

- 2 joints toriques 20 mm x 3 mm (https://lelebeck.de/1006.htm, référence 1164, 10 

centimes l’unité) 

- seringue en plastique (l’idéal est d’utiliser un capillaire en verre avec piston : 

https://www.drummondsci.com/capillary-micropipettes/wiretrol-i/, à condition que 

l’échantillon soit suffisamment petit) 

- deux platines de translation manuelles 

- une platine de translation contrôlable par ordinateur : 20 mm Linear Stage with 

Piezoelectric Inertia Drive 

(https://www.thorlabs.com/newgrouppage9.cfm?objectgroup_ID=12991, 

référence PD1/M) 

- Contrôleur : K-Cube™ Controllers for Piezo Inertia Stages (même adresse Thorlabs, 

référence KIM001) 

- Agarose à bas point de fusion 

(https://www.sigmaaldrich.com/catalog/product/sigma/a9045?lang=fr&region=FR) 

 

3. Protocole de préparation des échantillons 

 

Les étapes pour préparer et monter un échantillon dans le montage est le suivant : 

 

1. Préparer une solution d’agarose à 3% en masse dans de l’eau. Attention, si vous 

décidez d’observer un autre stade que la pupe, par exemple des larves qui ne sont 

pas protégées par une cuticule, il faut remplacer l’eau par une solution 

physiologique pour éviter tout choc osmotique qui dégraderait l’échantillon. Si la 

solution d’agarose est préparée à l’avance, elle va se gélifier à température 

ambiante. Il faut donc la faire fondre (au bain-marie) car la solution d’agarose doit 

être liquide dans un premier temps pour inclure une pupe à l’intérieur. 

 

2. Prélever délicatement une pupe sur la paroi d’un tube de culture avec une petite 

pince, et la déposer dans une boîte de Pétri. 

 

3. Déposer quelques gouttes de la solution d’agarose sur la pupe. 

 

4. Rapidement (avant que l’agarose ne gélifie !), aspirer la pupe dans l’agarose avec la 

seringue. Il faut essayer de faire en sorte que la pupe soit bien entourée d’agarose 

au-dessus d’elle et en-dessous. 

 

https://lelebeck.de/1006.htm
https://www.drummondsci.com/capillary-micropipettes/wiretrol-i/
https://www.thorlabs.com/newgrouppage9.cfm?objectgroup_ID=12991
https://www.sigmaaldrich.com/catalog/product/sigma/a9045?lang=fr&region=FR
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5. Attendre que l’agarose gélifie dans la seringue (1 ou 2 minutes). 

 

6. Une fois l’agarose gélifiée, pousser la seringue de manière à faire pendre un petit 

cylindre d’agarose à son extrémité. 

 

7. Remplir la cuve du montage d’eau. Fixer la seringue préparée au système de 

translation, et immerger le cylindre d’agarose dans l’eau. Positionner ce cylindre 

avec l’échantillon dans le faisceau d’excitation. 

 

 
Figure 6 - Pupe montée dans de l’agarose, suspendue à une seringue 

 

V. Acquisition et traitement d’images 
 

1. Acquisition d’images avec HCImage Live 

 

L’acquisition d’images avec la caméra Hamamatsu ORCA-Flash4.0 LT Digital Camera se fait 

avec le logiciel (payant) HCImage Live (https://hcimage.com/hcimage-overview/hcimage-

live/). La caméra est reliée par un câble USB à l’ordinateur. Il faut ensuite sélectionner la 

caméra sur le logiciel, dans l’onglet “Capture” (s’il ne s’affiche pas, cliquer sur “View” puis 

cocher “Capture pane”). On peut alors lancer l’acquisition en live, et faire des captures 

d’images depuis cet onglet “Capture”. La fenêtre “Image Display” permet de voir 

l’acquisition en live et de régler certains paramètres tels que le contraste. 

 

https://hcimage.com/hcimage-overview/hcimage-live/
https://hcimage.com/hcimage-overview/hcimage-live/
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Figure 7 - Logiciel d’acquisition d’images HCImage Live 

 

 

2. Obtention d’images 3D plan par plan sur ImageJ 

 

Ces images peuvent ensuite être traitées sur le logiciel (gratuit) ImageJ (ou sa version 

“étendue” Fiji : https://imagej.net/Fiji). On peut par exemple jouer sur le contraste des 

images, ou facilement mesurer des distances une fois l’échelle renseignée. La principale 

utilisation que nous avons faite de Fiji est la reconstitution d’images 3D plan par plan. 

 

 

Figure 8 - Interface du logiciel Fiji 

 

Pour obtenir une image 3D à partir d’une séquence d’acquisition de plans régulièrement 

espacés : 

 

1. Ouvrir la séquence d’images : File → Import → Image sequence. Ouvrir la première 

image d’un dossier, et indiquer le nombre d’images à ouvrir. On obtient alors un 

“stack” avec les images de la séquence, que l’on peut faire défiler. 

https://imagej.net/Fiji


11 
 

2. Régler l’échelle : Analyze → Set scale. 

3. Projection 3D du stack : Image → Stacks → 3D project. Une fenêtre s’ouvre avec 

plusieurs paramètres réglables. Il est notamment important d’indiquer 

l’espacement entre les plans. On peut également régler différents paramètres de 

contraste, d’opacité, etc. Pour une projection 3D entière, choisir : Initial angle = 0 

degrees, Total rotation = 360 degrees. L’incrément d’angle de rotation détermine 

le nombre d’images que va construire le logiciel (et donc le temps que cela va 

prendre !). Par exemple, un incrément de 10° pour une projection sur 360° 

nécessitera la construction de 36 images. Pour obtenir une vraie reconstruction 3D 

et non simplement une superposition de plans espacés par du vide, il faut cocher la 

case “Interpolate” (cela demande un plus long temps de calcul). 
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